
Appendix 1. 
 

OCCUPATION CHANGE  
DATA COLLECTION AND ANALYSIS GUIDE 

 
As one of the three principal elements of the Ford Foundation research project, the 
research team developed and employed a methodology to examine occupation 
changes in 22 colonias and informal low-income subdivisions (IfHSs) over the past 
decade.  The majority of these neighborhoods (20/22) formed part of an earlier lot 
density study, Residential Land Market Dynamics, Absentee Lot Owners and 
Densification Policies for Texas Colonias, written by Ward et al (2000). The following 
guide details the methods used for data collection and analysis in the hopes that future 
researchers will be able to conduct similar studies in other areas and is intended to 
serve as a compliment to Methodology chapter in the complete report  (Documenting a 
Decade of Lot Occupation Change in 22 Texas Colonias and Subdivisions). 
 
The data collection methodology is divided into three phases: lot coding, hard counts, 
and ownership searches. The analysis methodology is divided into information on the 
master database (included as a part of the report package) and guides for employing a 
few useful analysis tools found in Excel. 
 
In addition the following guide, this report package includes two Excel Workbooks: the 
study workbook and a master workbook. The Lot Occupation Study Workbook 
contains the database (first sheet) and the separate calculations that inform the findings 
and analysis in our study. The Master Template Workbook contains a database 
template that is intended to serve as a frame into which future researchers may enter 
their own data and conduct their own analysis.  
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DATA COLLECTION GUIDE 
 

 
PHASE ONE: LOT CODING 

 
1. Locate the colonia/IFHS in Google Earth, searching by the colonia/IfHSs name, a 

close street name or intersection, or beginning from a known landmark or place, 
such as a nearby city. 

 
***NOTE – Colonia/IFH Placemarks: We recommend that researchers create a 
placemark for each colonia/IfHS once they have located it in order to avoid the need to 
search for the location each time they return to Google Earth.  

 
Google Earth Search Box 

 

 
 
 

2. Use the Historical Imagery tool (shown below) to review available satellite images of 
the colonia/IfHS. Identify three images from three different years for the 
community(ies) that you wish to analyze. Try to ensure that the image dates for each 
colonia/IfHS are the same. For example, in our study, 2002, 2006, and 2010 were 
the preferred image dates, but when the specific dates were unavailable researchers 
selected the closest alternative. (Image dates for each community can be recorded 
in the General Information section of the master database (discussed below)). 
 

Google Earth Historical Imagery Tool 
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3. Use the placemarks available in Google Earth to code the lot occupancy statuses in 

each image according the satellite image coding guide below. Each placemark in the 
coding guide below is based on a specific lot occupancy combination. “V” stands for 
vacant. “O” stands for occupied. So, for example, if a lot is vacant in 2002, occupied 
in 2006, and vacant again in 2010 the lot occupancy combination would be V-O-V 
and the lot would be marked with the yellow with a black circle placemark. 

 
Satellite Image Coding Guide 
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(The grey triangle and the grey star are temporary placemarks. See Coding Methods 
below for more information.)  
In phase one, researchers also code alternative-use lots using the red triangle with a 
black exclamation point placemark (pictured below). However, alternative-use lots 
should only be coded in the most recent image (see Coding Methods below and 
Tracking Changes Over Time in the report’s Methodology chapter). Future research 
might benefit from creating several placemarks (similar to the system used in the guide 
above) to track changes in alternative-use lots.    
 

(Red triangle with exclamation point): Indicates alternative land use. For 
example, the lot is used to park cars or for some other clear industrial or commercial 
use. 
 
 
Particularly during Phase One, researchers could benefit from using a placemark to 
identify questions or concerns. For example, marking and reviewing lots when the 
occupancy status is questionable, i.e. the researcher is unsure of whether to mark the 
lot as vacant or occupied could help researchers build more nuanced and contextually 
informed definitions for “occupied” versus “vacant” lots. (See the Identifying Structures 
and Deciding on Definitions section of the Methodology chapter for more information on 
building definitions.) We suggest that researchers store specific information about the 
question/concern in the placemarks note section pictured below in new placemark 
window) and keep a close record of their ultimate decision regarding the lot in question.  
 

(Volcano): Indicates unknown occupancy or a question/concern.  
 
____________________________________________________ 
 
 
Adding a Placemark 
 
To add a placemark to the satellite image click the Google Earth placemark tool (below) 
and select from the options.  
 

 
Google Earth Placemarks Tool 
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A new placemark window will open into which you can enter additional information, such 
as the image date. For example, we entered the differing image dates for the dark blue 
placemark (see the coding guide) in the name window at the top so that it would be 
displayed on the satellite image with the pushpin. The new placemark window also 
provides a number of options to change/adjust the placemarks.  To edit existing 
placemarks right click the placemark and select Properties. 
 

 
New Placemark Window 

 

 
 
____________________________________________________ 

 
 
 
Drawing Property Lines 
 
Using Google Earth’s polygon tool (below) to draw property lines on the satellite image 
may facilitate the process of identifying vacant and occupied lots (see Tracking 
Changes Over Time section in the Methodology chapter). More information on the 
polygon tool is also available in the Google Earth tutorials provided over the internet, 
free of charge. If available from the county’s tax appraisal office you might also pull plat 
maps to verify the property lines. When plat maps are not available it is usually OK to 
assume relatively uniform lot sizes.  
 
 

Google Earth Polygon Tool 
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Coding Methods 
 
 
Our research team members used two different methods to code the satellite images. 
Both methods should yield the same results. However, some researchers may prefer 
one method over the other, depending on their personal working style.  Method A is 
based on completely analyzing the satellite images of the colonia/IfHSs one-by-one. 
Method B is based on following the changes in individual lots of the colonia/IfHS over 
the three images.  
 
 
Method A: 

o Visually scan the 1st image (2002) and mark all vacant lots with red with a 
black square placemark  

o Move to the 2nd image (2006) and review the previously marked lots. If the 
previously vacant lot is now occupied, replace the previous placemark (red 
with a black square) with the temporary vacant-occupied (VO) marker (the 
grey star placemark) 

o Scan the 2nd image  and mark any new vacant lots with the temporary 
occupied-vacant (OV) marker (the grey triangle placemark) 

o In the 3rd image (2010), review previously marked lots for changes (e.g. 
VOO, VOV, OVO, and OVV) altering the placemarks as needed (see 
coding guide above) 

o Scan the 3rd image and mark any new vacant lots with the magenta 
placemark (OOV) 

o Scan the 3rd image again, this time marking any alternative uses with the 
red triangle with an exclamation point placemark 

 
Method B: 

o Visually scan the 1st image (2002) and mark all vacant lots with red with a 
black square placemark 

o On a lot-by-lot basis: 
 Check the previously marked lots for changes in the 2nd (2006) and 

3rd (2010) images (Use the historical imagery tool to flip through the 
images). 

 In the 3rd image (2010) replace the initial red with a black square 
placemark with the appropriate placemarks based on the 
occupancy changes observed in the 2nd and 3rd image (VOO, VOV, 
OVO, and OVV) 
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o Return to the 2nd  image (2006) and mark any new vacant lots with the 
temporary occupied-vacant (OV) marker ( the grey triangle) 

o Go to the 3rd image (2010) and adjust the newly marked vacant lots (grey 
triangle) from the 2nd image to according to any changes in occupancy 
(OVO - teal, OVV - green) 

o Scan the 3rd image for any new vacant lots and mark them  with the 
magenta placemark (OOV) 

o Scan the 3rd image again, this time marking alternative-uses with the red 
triangle with an exclamation point placemark  

 
 
____________________________________________________ 
 
 
 
A Note on Storing Placemarks 
 
To the side of the virtual globe in Google Earth there is a window that displays any 
added placemarks, as well as a search box and layers options. Throughout the coding 
process it is important to save the placemarks. Google Earth is a rather large program 
and, depending on the computer’s capacity, the program may close unexpectedly.  New 
placemarks will appear automatically under the “Temporary Places” folder. Temporary 
places will not be saved once the program has closed. Thus, it is a good idea to store all 
placemarks in the My Places folder which saves the placemark data in the program. 
The entire My Places folder, sub-folders within “My Places”, and even individual 
placemarks, can also be saved as .kmz files, enabling researchers to share information 
and to work on multiple machines. If a researcher plans to work on the same machine 
throughout the process, Google Earth will save the My Places data and the placemarks 
will appear each time the program is opened. Nonetheless, we strongly suggest that 
researchers keep multiple backups of the .kmz files throughout the project.    
  
Organization within My Places is also important. If the researcher is working on multiple 
colonias, then clearly it will be important to have a different folder for storing placemarks 
for each colonia. New folders can be added to the My Places folder by right clicking the 
mouse and selected add, then folder.  In addition, the researcher may want to create 
folders for each individual placemark, e.g. a folder for red, with a black square, 
placemarks, a folder for magenta placemarks, etc. Creating individual folders will greatly 
reduce the time needed for Phase Two (see below). Initially, as placemark colors will 
change throughout the coding process, it may be frustrating to keep the placemarks 
separated. The researcher may prefer to wait until the coding is completed and then 
create individual folders before dragging and dropping each individual placemark into 
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the appropriate folder.  In our experience organizing the placemarks in this way 
was well worth the time and effort.   
 

PHASE TWO: HARD COUNTS 
 
 
1. Count the total number of lots in the community based on the property divisions 

taken from plat maps or assumed during the first phase.  
 

***NOTE - Property Lines:  Total lot counts can be broken down to ease calculation by 
storing counts of total lots per street in placemarks and then summing up the totals from 
the street placemarks. 
 
***NOTE – Alternative-Use Lots: The lots that have been marked as alternative-use lots 
(red triangle with exclamation point placemark) should also be included in the total lot 
count (see Phase Two: Hard Counts section in the Methodology chapter for more 
information). 
 
 
 
2. Tally the placemarks for each community 
 
***NOTE – See the A Note on Storing Placemarks above). 
 
 

 
3. Add the total lot and placemark counts to the Excel database sheet (further 

discussed below) 
 

 
***NOTE – Automatically Generated Figures: Most of the master database is 
automatically populated based on placemark data. For example, vacant lot counts for 
each image are automatically generated based on the following placemark 
combinations.  
 

 Image 1 (2002):  red with black square (VVV), both dark blue placemarks (i.e. 
dark blue placemarks with white writing for image 2 (2006) (VVO) and image 3 
(2010) (VOO)), and yellow placemarks (VOV). 
 

 Image 2 (2006): red with black square (VVV), dark blue with image 2 date in 
white letters (2006) (VVO), teal (OVO), and green (OVV) placemarks. 
 



 

 

9 

 

 Image 3 (2010): red with black square (VVV), yellow (VOV), green (OVV), and 
magenta (OOV) placemarks. 

 
 

PHASE THREE: COMBINED LOTS 
 
 
This phase is only for those lots that are vacant in the most recent satellite image 
(2010): 
- red with a black square placemarks 
- magenta placemarks 
- green placemarks 
- yellow with a black circle placemarks  

  
In phase three researchers obtain property ID’s and ownership information for the 
appropriate vacant lots, as well as for any adjacent lots. Using the ownership 
information, researchers identify vacant lots that are owned by the developer and lots 
that are formally or informally combined.  
 
The combined lots guide is divided into two sections – Obtaining Property IDs and 
Ownership Information and Marking Lot Combinations - to ensure clarity. However, we 
suggest that researchers conduct the property searches and mark the developer-owned 
lots and lot combinations as one process, e.g. on a lot-by-lot basis researchers should: 
 
 

1.) Locate the precise lot in both Google Earth and the tax appraisal map 
 

2.) Review the owner information for the vacant lot and all adjacent lots (in the tax 
appraisal map(s)) 
 

3.) If relevant, add a placemark to the vacant lot denoting it as a developer-owned 
lot or as a lot combination in Google Earth (placemarks below) 
 

County Information: 
 
Often both information about which county a colonia/IfHS is located in and the 
appropriate county tax appraisal website can be found through internet searchers. For 
example, researchers could search “Cameron Park, Texas” in order to identify county 
information and then search “Cameron County AND Tax Appraisal” in order to locate 
the tax appraisal website. However, the internet searches are only likely to work for very 
large and/or established colonias. Another, potentially more complicated, option would 
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be to review county level maps of the area and locate the exact location of the colonia 
or IfHS. (The county names can be recorded in the General Information section of the 
master database, discussed below). 
 

Obtaining Property IDs and Ownership Information 
 
1. Identify the precise location of a vacant lot in the most recent satellite image in 

Google Earth. For example, a precise location may be the seventh lot on the eastern 
end of the street, on the south side. Identifying the precise location of a given lots is 
vital as the researcher will need to locate the exact same lot on the tax appraisal 
map. 
 

2. Identify the same vacant lot and its property ID number in the tax appraisal map for 
the county where the colonia/IfHS is located 

 
a. Locate the property search in the tax appraisal website for the county where 

the community is located 
 

b. Searching under property address, use a street name from the colonia/IFH to 
search for and view the tax appraisal map of the area. (The street names 
should be automatically displayed in the Google Earth images. If necessary, 
street names can be added/removed by checking the appropriate box in the 
Layers window, located in the lower right-hand corner of Google Earth). Open 
the map in a new window. 

 
 

 

Property Address Search Example 
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Property Address Search – View Map Option 
 

 
 
 

c. In the tax appraisal map, locate the same vacant lot previously identified in 
Google Earth. Note the lot’s property ID number. (Property ID information can 
be stored in the placemarks in Google Earth). 

 

Tax Appraisal Map Displaying Property IDs 
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3. Return to the tax appraisal website’s property search and, this time searching under 
account number; enter the property ID number displayed on the tax appraisal map to 
find ownership information for the vacant lot.  

 
 

Property ID Search Example 
 
 

 
 
a. Note the ownership information for the given lot, i.e. the owner’s name. 

(Ownership information can be stored in the placemarks in Google Earth). 
 

 

Owner Name Location in the Property ID Search 
. 
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b. Repeat the previous steps for all adjacent lots. Adjacent lots are ALL lots that 
share a property line with the vacant lot in question 

 
*** NOTE - Comparing Google Earth and Tax Appraisal Maps: If possible, we suggest 
that researchers conduct the phase three searches in tandem keeping both the Google 
Earth and the Tax Appraisal windows open and side-by-side on their computer screen. 
This greatly facilitates correctly matching the lots in both windows. Property lines 
marked using Google Earth’s polygon tool will also speed up the comparative process. 
Alternatively, if conducting the searches in tandem is not an option, our team found it 
useful to add ownership and property information to the placemarks in Google Earth so 
that the data was available for quick reference.  
 
***NOTE – Layers in Tax Appraisal Maps: Some tax appraisal websites will have 
multiple maps layers that will provide the option to display, among other information, 
property IDs and owner names. Where this is the case, the researchers will be able to 
bring up the ownership information directly on the map rather than returning to do a 
search by the property ID.    

 
Example of Tax Appraisal Map with Multiple Layers 
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Marking Lot Combinations 
 
 
The ownership information pulled from the tax appraisal website is used to identify 
vacant lots in the most recent image that are developer-owned and both formal and 
informal lot combinations. Although information on developer-owned lots and combined 
lots cannot be used to recalculate the colonia/IfHS occupancy levels, it does provide 
insights into the degree of influence these processes likely have on the community’s 
overall vacancy. 
 
All placemarks for lot combinations should be ADDED to a given property. DO 
NOT delete any of the previous placemarks as they trace a different phenomenon 
– lot occupation changes.   
 

Lot Ownership Coding Guide 
 

Ownership/Combinations Placemarks 

Developer-Owned Lot Blue Flag 
  

Formal Lot Combination Yellow House 
  

Informal Lot Combination Gray Bubble 

  

 
 
Developer-Owned Lots:  
 
If a particular name appears several times in the property searches it is possible that 
this person is the developer. It is very important that the repeated name is identical, or 
so similar as to avoid any reasonable doubt. Developer names can be confirmed 
through discussions with community members or by examining a plat map. If the 
researcher is reasonably certain that a lot is developer owned, she/he should add a 
blue flag placemark to the lot to indicate developer ownership.  
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Lot Combinations: 
 
Lot combinations occur when two or more lots belong to the same owner(s). 
Combinations can be formal (i.e. registered) or informal. When a lot combination is 
formal the tax appraisal map will provide one property ID for two adjacent lots, i.e. the 
property line will be redrawn to surround both lots and one ID will describe the newly 
created larger lot. When the tax appraisal maps reveal that two or more lots have been 
formally combined add a yellow house placemark to each combined vacant lot in 
Google Earth.  
 
Often two or more lots will have owner names that are exactly the same or very similar, 
but will still have two different property IDs. For example, lot A might be registered to 
Joe Hernandez Morales and lot B registered to Joe. M. Hernandez, or lot A might be 
registered to Jose Miguel Smith and lot B registered to J.M. Smith. When it appears 
probable that the same person owns both lots but has just not formally registered them 
under one property ID, the lots are considered to be informally combined. Mark 
informal lot combinations by adding a grey bubble pushpin to any vacant lots in the 
combination.  
 
If there are two vacant lots that form a lot combination (formal or informal) add a yellow 
house placemark or grey bubble to each lot. 
 
The total number of formally combined and informally combined lots, as well as 
the total number blue flag developer placemarks, should be recorded in the 
Placemarks section of the database Excel sheet (discussed below). 
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ANALYSIS GUIDE 
 
 
Master Database 
 
The master database is located in the master workbook (included as a part of this report 
package). The database holds satellite image coding data and generates additional 
information for analysis on the basis of those numbers. The database has ten sections. 
Only the first two sections require data entry; the remaining sections are automatically 
sourced to and/or are calculated from the entered data. The formulas for calculating 
the automatically generated data are included in the section or title columns. 
Each section is briefly described below.  
 
1. General Information (columns B through G) - holds data such as the colonia/IfHS 

name, the county where it is located, and the total number of lots, as well as the 
precise date for each  of the satellite images examined in Google Earth  
 

2. Placemarks (columns H through R) -  holds lot occupancy change placemark tallies, 
as well as lot ownership placemark tallies 

 
3. Vacant Lots Counts (columns S through V) –generates vacant lot counts for each 

image from the Google Earth analysis and an overall change in vacancy 
measurement based on specific placemark combinations. (For more information see 
Phase 2 in the Methodology chapter).  

 
4. Occupied Counts (columns W through Y) –generates occupied lot counts for each 

image from the Google Earth analysis  
 

5. Vacancy Levels (columns Z through AB) - generates vacancy level percentages for 
each image in the Google Earth analysis  
 

6. Occupancy Changes (columns AC through AE) - generates change in occupancy 
percentages for time horizons B and C based on the difference between vacancy 
levels in the satellite images. For example, the occupancy change for time horizon B 
is based on the difference between the percentage of vacant lots in 2002 and the 
percentage of vacant lots in 2006.  
 

7. Infill (columns AF through AS) – contains two subsections. The 1st subsection 
(columns AF through AL) contains generated infill hard counts, based on placemark 
combinations, for time horizons B and C.  The 2nd subsection (columns AM through 
AS) generates infill percentages, based on previous hard counts, such as the 
percentage of lots that experienced early infill and remained occupied.  
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8. Outflow (columns AT through BG) – contain two sections. The 1st subsection 

(columns AT through AZ) contains generated outflow hard counts, based on 
placemark combinations, for time horizons B and C. The 2nd subsection (columns BA 
through BG) contains generated percentages, based on the previous hard counts, 
such as the percentage of lots that experienced early outflow, but were later 
reoccupied.  
 

9. Current Vacancies- Ownership (columns BH through BO) - identifies the 
percentage of lots that were never occupied (based on the previously entered 
placemark and vacancy data), as well as percentage data that relates to ownership 
of vacant lots in the last image, such as the percentage of currently vacant lots that 
are developer owned, or the percentage of currently vacant lots that are formally or 
informally combined.  

 
10. Alternative Use (columns BP) - calculates the percentage of currently occupied lots 

that are alternative use lots based on the data entered for the alternative placemark 
in section 2.   

 
The master database also has three additional rows located below the data section that 
provide aggregate numbers based on the individual colonia data that has been entered 
and/or generated.  
 

 Total #s (row 28, highlighted in red) - generates sums of the data where 
appropriate, such as the total number of vacant lots in 2002 (W28) or the total 
number of lots that experienced ReOutflow (AY28). 
 

 Total %s (row 29, highlighted in yellow) - uses the numbers generated in the total 
#’s row to generate aggregate percentages, such as the overall vacancy level for 
2002 (Z29) or the percentage of all currently vacant lots that have never been 
occupied (BH4). 
 

 Difference (row 30, highlighted in blue) - calculates the difference between 2 given 
numbers, such as T30, which calculates the difference between the total vacant lots 
in 2002 and the total vacant lots in 2006. 
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Adjusting the Database to your Own Data  
 
The current master database has 22 rows available for entering information on 22 
communities and sixty-seven columns for data entry and calculations. Additional 
columns can be easily inserted should the researcher desire to create additional 
calculations (right-click the desired column letter and select insert from the drop down 
menu), and the number of rows can  be easily  reduced by deleting unnecessary rows 
(right-click the desired row number and select delete from the drop down menu).  
However, adding rows is more complicated (right-click the desired row number and 
select insert from the drop down menu) as the formula informing the other columns and 
rows will not automatically transfer. 
 
Since the majority of the columns are based on formulas, it is very important to make 
sure that the formula is applied to each row in a given column, i.e. to ensure that each 
cell contains the appropriate formula. Thus, we suggest that the researcher return to the 
first cell in each column after all new rows have been added. Once a cell is selected (by 
clicking on it) a small white plus symbol will appear in the lower right hand corner of the 
cell. The red circle in Figure 2.2 highlights the plus symbol. When the mouse is placed 
over the small white plus symbol, the cursor becomes a slightly larger black plus 
symbol. Clicking on the plus symbol and dragging the cursor down to select each 
additional row will automatically transfer the correct formula to the newly add rows. 
However, we recommend that the researcher click on a few of the individual cells, 
particularly those in newly added rows, to ensure that the formula has transferred 
correctly (see formula reveal in the Methodology section of the paper). 
 

Formula Pull Down Option in Excel 
 

 
 
 
Researchers may also want to change the elements of the title/category row. 
Specifically, researchers are encouraged to change the dates specified in the titles and 
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formulas to match their own study. Dates can be easily adjusted by using the find and 
replace feature in Excel. The feature can be accessed by clicking the Find and Select 
button under the home tab (symbolized by pair of binoculars) and selecting Replace 
from the drop down menu or simply by clicking CTRL, F on the keyboard. Both options 
will pull up the find window, pictured below (Figure 2.3). In the Find and Replace, click 
the Replace tag. In the Find what box, enter the year you would like to replace and in 
the Replace with box enter the new year you will be using. Make sure to select the 
title/category row before using Find and Replace to ensure that other data is not 
altered.  
 

Find and Replace Window in Excel 
 

 
 

 
 
Additional Useful Tools in Excel 
 
During the analysis phase researchers may become frustrated by the need to scroll 
through and around the database. Excel’s hide and freeze options provide easy options 
to manage worksheets and to review data.  
 
Excel’s Hide Option  
 
The hide option hides selected cells from view on the worksheet screen. The rows, 
columns and data are preserved, but out of sight. For example, the option could be 
used to hide the individual colonia data, enabling researchers to easily review the 
aggregate numbers generated in the highlighted rows at the bottom of the sheet, as well 
as the title/category to which the rows refer.  
 
To hide columns rows: 

1. Select the area you would like to hide 
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2. Right-click the mouse and select Hide from the options window that appears 
(displayed below) 

To unhide columns/rows: 
1. Select the columns/row around the area that was previously hidden (easily 

identified by looking for jumps in the numbering or lettering sequence, e.g. 1, 2, 
3, 10 or A, B, C, H).  

2. Right click the mouse and select Unhide from the options widow that appears 

 
Screen Shot of the Hide Option in Excel 

 

 
 
 
 
Excel’s Freeze Option 
 
The freeze option keeps selected columns or rows from moving while allowing others to 
move. Researchers could use this option to scroll through the database’s other column 
data while keeping the column with the colonia names frozen, avoiding the need to 
scroll back and forth to link the data in the columns to the specific colonia to which they 
refer.   
 
 
 



 

 

21 

 

To freeze columns/rows: 
 

1. Under the View tab, click on the Freeze Panes icon 
2. Select one of three options in the pop-down window: Freeze Panes, Freeze Top 

Row and Freeze First Column. While the last two options freeze specific 
rows/columns, the first option can be used to freeze and row/column on the 
worksheet. To use the Freeze Panes options selected the row or column after 
the pane you would like to Freeze, then return to view tab and click on Freeze 
panes 

 
To unfreeze columns/rows: 

1. Under the View tab, click on Freeze Panes 
2. Select the option in the pop down window that refers to the row(s)/column(s) that 

you would like to unfreeze (e.g. Unfreeze Panes, Unfreeze Top Row, Unfreeze 
First Column). 

 
Screen Shot of the Freeze Option in Excel 
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Excel also contains several easy-to-use tools that can be used to further analyze 
information in the database worksheet. For each of the following tools, we recommend 
selecting and copying the data you wish to analyze into a new worksheet to avoid 
accidental changes to the formulas or entered data.  
 
Sort and Filter Tool  
 
The Sort and Filter tool permits researchers to custom sort and organize multiple 
columns of data according to the order of a single column. In the example used for the 
following images, the County and Colonias columns are organized according to the 
sequential ordering of the Overall Change in Occupancy Column.  
 
To use the Sort and Filter tool: 
 
1.  Select the entire table, including titles. Under the Home tab, click on the Sort and 

Filter button and select Custom Sort, identified with red arrows in the image below.   

Sort and Filter and Custom Sort Locations in Excel 
 

 
 

2. A sort window (pictured below) will open. Under the Sort By menu select the name 
of the column you would like order and use to the other columns. As previously 
mentioned, in this example columns will be sorted by the Overall Change in 
Occupancy ordering (identified in the sort window and the excel sheet with red 
rectangles). Sort according to Values from lowest to highest (A to Z).  

3.  
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Sort Window 
 

 
 
 
4. Excel will resort the rows according to the order of the chosen column (in this case 

Overall Occupancy Change). For example, in the table in the previous sort window 
image and in the Resorted columns image below, the overall occupancy change for 
Rancho Vista was -1%. In the latter image, however, the Rancho Vista and 
Guadalupe County cells have been moved to the top of the list as they are 
associated with lowest overall occupancy change in the group.  

Resorted Columns 
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Correlations 
 
Researchers can use the correlation tool to examine the relationship between study 
variables as well as the relationship between study variables and any externally 
collected variables that may be of interest.  
 
First, make sure that the version of Excel you are using has the data analysis tool kit. 
There should be a tab called “data” on the top of the Excel window (the tab is located 
where “File”, “Home”, “Insert” etc.) If the data tab is not visible, you do not have the data 
analysis toolkit.  
 
To add the Tool Kit: 
 

1. (In Excel) Go to the File  tab and select Excel Options  
2. Click Add-Ins. 
3.  In the Manage box (located in the lower left corner of the window) select Excel 

Add-ins and click Go  
4. In the pop-up add-ins available box, check the box next to Analysis Tool pack. 

The tool pack should automatically begin to download. 

To run a correlation analysis: 
 

1. Copy and paste the two variables that you would like to test into a new worksheet 
2. Under the Data tab, click the Data Analysis icon. In the pop up window, select 

Correlation and click ok 

 
Correlation Analysis Location in Excel 
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3. A correlation window will open (pictured below). Click inside of the window next 
to Input Range and select the entire table that you would like to analyze (see 
blue rectangles). Make sure to check the columns or rows option immediately 
below, depending on how your data is analyzed. In the case, the variables are 
organized into two columns - Overall Occupancy Change and Base Vacancy 
(see the top blue arrow). If you selected the titles as well as the data, make sure 
to check the box next to Labels in the First Row (see the bottom blue 
arrow).Finally, select the bubble next to Output Range and, after click inside of 
the adjacent window, select the area where you would like the correlation 
analysis numbers to appear.  

 
 

Correlation Data Entry Window 
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Correlation Analysis Result 
 

 
 
 
For information on interpreting correlation analysis numbers see Correlations in 
the Methodology chapter 
 
 
 


